OpenEdge Reporting: Deploying Crystal Reports
4. Crystal Reports and Database Security ........................................ 4–1
   Using logon validation .......................................................... 4–2
   Logon validation guidelines ............................................... 4–3
   Assigning privileges ............................................................. 4–4
   Using password protection ................................................... 4–5
   Creating a new report parameter ........................................ 4–5
   Creating a new password ..................................................... 4–7
   Verifying your new password .............................................. 4–9

Index ...................................................................................... Index–1
Preface

This Preface contains the following sections:

• Purpose
• Audience
• Organization
• Typographical conventions
• OpenEdge messages
• Third party acknowledgements
OpenEdge Reporting: Deploying Crystal Reports

Purpose

To provide a basic introduction to using Crystal Reports® in the OpenEdge™ development environment. For more detailed information, users should refer to Crystal Reports documentation and online Help. Users who require technical support should refer to Business Objects technical support.

For the latest documentation updates see the OpenEdge Product Documentation category on PSDN http://www.psdn.com/library/kbcategory.jspa?categoryID=129.

Audience

This manual is for OpenEdge developers who are new to Crystal Reports.

Organization

Chapter 1, “Introduction”

Provides you with information on connecting Crystal Reports to an OpenEdge database. It also offers procedures for creating a sample database that can be used to demonstrate Crystal Reports’ capabilities.

Chapter 2, “Creating a Crystal Reports Document”

Shows you how to use Crystal Reports to create a simple report.

Chapter 3, “Crystal Reports Design Basics”

Shows how to format a Crystal Reports document.

Chapter 4, “Crystal Reports and Database Security”

Provides guidelines for using logon validation, user privileges, and password protection.
## Typographical conventions

This manual uses the following typographical conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Bold typeface indicates commands or characters the user types, or the names of user interface elements.</td>
</tr>
<tr>
<td><em>Italic</em></td>
<td>Italic typeface indicates the title of a document, provides emphasis, or signifies new terms.</td>
</tr>
<tr>
<td>SMALL, BOLD CAPITAL LETTERS</td>
<td>Small, bold capital letters indicate OpenEdge key functions and generic keyboard keys; for example, GET and CTRL.</td>
</tr>
<tr>
<td>KEY1-KEY2</td>
<td>A hyphen between key names indicates a <em>simultaneous</em> key sequence: you press and hold down the first key while pressing the second key. For example, <strong>CTRL-X</strong>.</td>
</tr>
<tr>
<td>KEY1 KEY2</td>
<td>A space between key names indicates a <em>sequential</em> key sequence: you press and release the first key, then press another key. For example, <strong>ESCAPE H</strong>.</td>
</tr>
</tbody>
</table>

### Syntax:

| **Fixed width**                    | A fixed-width font is used in syntax statements, code examples, and for system output and filenames. |
| **Fixed-width italics**            | Fixed-width italics indicate variables in syntax statements. |
| **Fixed-width bold**               | Fixed-width bold indicates variables with special emphasis. |
| **UPPERCASE fixed width**          | Uppercase words are Progress® 4GL language keywords. Although these always are shown in uppercase, you can type them in either uppercase or lowercase in a procedure. |

![Multi-step Procedure](image)

This icon (three arrows) introduces a multi-step procedure.

![Single-step Procedure](image)

This icon (one arrow) introduces a single-step procedure.
OpenEdge messages

OpenEdge displays several types of messages to inform you of routine and unusual occurrences:

- **Execution messages** inform you of errors encountered while OpenEdge is running a procedure; for example, if OpenEdge cannot find a record with a specified index field value.

- **Compile messages** inform you of errors found while OpenEdge is reading and analyzing a procedure before running it; for example, if a procedure references a table name that is not defined in the database.

- **Startup messages** inform you of unusual conditions detected while OpenEdge is getting ready to execute; for example, if you entered an invalid startup parameter.

After displaying a message, OpenEdge proceeds in one of several ways:

- Continues execution, subject to the error-processing actions that you specify or that are assumed as part of the procedure. This is the most common action taken after execution messages.

- Returns to the Progress Procedure Editor, so you can correct an error in a procedure. This is the usual action taken after compiler messages.

- Halts processing of a procedure and returns immediately to the Progress Procedure Editor. This does not happen often.

- Terminates the current session.

OpenEdge messages end with a message number in parentheses. In this example, the message number is 200:

```
** Unknown table name table. (200)
```

If you encounter an error that terminates OpenEdge, note the message number before restarting.
Obtaining more information about OpenEdge messages

On Windows platforms, use OpenEdge online help to obtain more information about OpenEdge messages. Many OpenEdge tools include the following Help menu options to provide information about messages:

- Choose Help → Recent Messages to display detailed descriptions of the most recent OpenEdge message and all other messages returned in the current session.
- Choose Help → Messages and then enter the message number to display a description of a specific OpenEdge message.
- In the Progress Procedure Editor, press the HELP key or F1.

Third party acknowledgements


OpenEdge includes software developed by the Apache Software Foundation (http://www.apache.org/). Copyright © 1999 The Apache Software Foundation. All rights reserved (Xerces C++ Parser (XML) and Xerces2 Java Parser (XML)); Copyright © 1999-2002 The Apache Software Foundation. All rights reserved (Xerces Parser (XML); and Copyright © 2000-2003 The Apache Software Foundation. All rights reserved (Ant). The names “Apache,” “Xerces,” “ANT,” and “Apache Software Foundation” must not be used to endorse or promote products derived from this software without prior written permission. Products derived from this software may not be called “Apache”, nor may “Apache” appear in their name, without prior written permission of the Apache Software Foundation. For written permission, please contact apache@apache.org. Software distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product.


OpenEdge includes software developed by Vermont Creative Software. Copyright © 1988-1991 by Vermont Creative Software.

OpenEdge includes code licensed from RSA Security, Inc. Some portions licensed from IBM are available at http://oss.software.ibm.com/icu4j/.
OpenEdge Reporting: Deploying Crystal Reports

OpenEdge includes the UnixWare platform of Perl Runtime authored by Kiem-Phong Vo and David Korn. Copyright © 1991, 1996 by AT&T Labs. Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software. THIS SOFTWARE IS BEING PROVIDED “AS IS”, WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHORS NOR AT&T LABS MAKE ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

OpenEdge includes the RSA Data Security, Inc. MD5 Message-Digest Algorithm. Copyright ©1991-2, RSA Data Security, Inc. Created 1991. All rights reserved.

OpenEdge includes software developed by the World Wide Web Consortium. Copyright © 1994-2002 World Wide Web Consortium, (Massachusetts Institute of Technology, European Research Consortium for Informatics and Mathematics, Keio University). All rights reserved. This work is distributed under the W3C® Software License [http://www.w3.org/Consortium/Legal/2002/copyright-software-20021231] in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

OpenEdge includes Sonic software, which includes software developed by Apache Software Foundation (http://www.apache.org/). Copyright © 1999-2000 The Apache Software Foundation. All rights reserved. The names “Ant”, “Axis”, “Xalan”, “FOP,” “The Jakarta Project”, “Tomcat”, “Xerces” and/or “Apache Software Foundation” must not be used to endorse or promote products derived from the Product without prior written permission. Any product derived from the Product may not be called “Apache”, nor may “Apache” appear in their name, without prior written permission. For written permission, please contact apache@apache.org.

OpenEdge includes Sonic software, which includes the JMX Technology from Sun Microsystems, Inc. Use and Distribution is subject to the Sun Community Source License available at http://sun.com/software/communitysource.

OpenEdge includes Sonic software, which includes software developed by the ModelObjects Group (http://www.modelobjects.com). Copyright © 2000-2001 ModelObjects Group. All rights reserved. The name “ModelObjects” must not be used to endorse or promote products derived from this software without prior written permission. Products derived from this software may not be called “ModelObjects”, nor may “ModelObjects” appear in their name, without prior written permission. For written permission, please contact djacobs@modelobjects.com.
Preface

OpenEdge includes Sonic software, which includes files that are subject to the Netscape Public License Version 1.1 (the “License”); you may not use this file except in compliance with the License. You may obtain a copy of the License at http://www.mozilla.org/NPL/. Software distributed under the License is distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License. The Original Code is Mozilla Communicator client code, released March 31, 1998. The Initial Developer of the Original Code is Netscape Communications Corporation. Portions created by Netscape are Copyright © 1998-1999 Netscape Communications Corporation. All Rights Reserved.

OpenEdge includes software Copyright © 2003-2006, Terence Parr All rights reserved. Neither the name of the author nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. Software distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product.

OpenEdge includes ICU software 1.8 and later - Copyright © 1995-2003 International Business Machines Corporation and others All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation.

OpenEdge includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/). Copyright © 1998-2007 The OpenSSL Project. All rights reserved. This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by Tim Hudson (tjh@cryptsoft.com). Copyright © 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project. Software distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product.

OpenEdge includes Sonic software which includes a version of the Saxon XSLT and XQuery Processor from Saxonica Limited that has been modified by Progress Software Corporation.
OpenEdge Reporting: Deploying Crystal Reports

The contents of the Saxon source code and the modified source code file (Configuration.java) are subject to the Mozilla Public License Version 1.0 (the “License”); you may not use these files except in compliance with the License. You may obtain a copy of the License at http://www.mozilla.org/MPL/ and a copy of the license (MPL-1.0.html) can also be found in the installation directory, in the Docs7.5/third_party_licenses folder, along with a copy of the modified code (Configuration.java); and a description of the modifications can be found in the Progress SonicMQ and Progress Sonic ESB v7.5 README files. Software distributed under the License is distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License. The Original Code is The SAXON XSLT and XQuery Processor from Saxonica Limited. The Initial Developer of the Original Code is Michael Kay (http://www.saxonica.com/products.html). Portions created by Michael Kay are Copyright © 2001-2005. All rights reserved. Portions created by Progress Software Corporation are Copyright © 2007. All rights reserved.

OpenEdge includes software developed by IBM. Copyright © 1995-2003 International Business Machines Corporation and others. All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation. Software distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product. Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.

OpenEdge includes Sonic software, which includes software developed by ExoLab Project (http://www.exolab.org/). Copyright © 2000 Intalio Inc. All rights reserved. The names “Castor” and/or “ExoLab” must not be used to endorse or promote products derived from the Products without prior written permission. For written permission, please contact info@exolab.org. Exolab, Castor and Intalio are trademarks of Intalio Inc.

OpenEdge includes Sonic software, which includes software Copyright © 1999 CERN - European Organization for Nuclear Research. Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. CERN makes no representations about the suitability of this software for any purpose. It is provided "as is" without expressed or implied warranty.
OpenEdge includes Sonic software, which includes software developed by the University Corporation for Advanced Internet Development http://www.ucaid.edu Internet2 Project. Copyright © 2002 University Corporation for Advanced Internet Development, Inc. All rights reserved. Neither the name of OpenSAML nor the names of its contributors, nor Internet2, nor the University Corporation for Advanced Internet Development, Inc., nor UCAID may be used to endorse or promote products derived from this software and products derived from this software may not be called OpenSAML, Internet2, UCAID, or the University Corporation for Advanced Internet Development, nor may OpenSAML appear in their name without prior written permission of the University Corporation for Advanced Internet Development. For written permission, please contact opensaml@opensaml.org.

OpenEdge includes DataDirect products for the Microsoft SQL Server database which contains a licensed implementation of the Microsoft TDS Protocol.

OpenEdge includes Sonic software, which includes code licensed from Mort Bay Consulting Pty. Ltd. The Jetty Package is Copyright © 1998 Mort Bay Consulting Pty. Ltd. (Australia) and others.
OpenEdge Reporting: Deploying Crystal Reports
Introduction

Crystal Reports from Business Objects has been designated as a reporting tool for OpenEdge Release 10. Crystal Reports interacts with the OpenEdge RDBMS through the OpenEdge SQL interface. This chapter provides you with information on connecting Crystal Reports to an OpenEdge database. It also offers procedures for creating a sample database that can be used to demonstrate Crystal Reports’ capabilities as described in the following sections:

- Creating a sample database
- Starting the sample database
- Configuring the ODBC driver
Creating a sample database

You can easily create a sample database you can work with while becoming familiar with Crystal Reports. Once the database is created, you can connect to it with Crystal Reports and use the database to follow the examples in this manual. The examples demonstrate Crystal Reports basic capabilities.

In the following example, the database is created by copying the Sports2000 database and naming the new database Sports2004. Creating a copy of the Sports2000 database involves running PROENV to set up your OpenEdge environment and then using the prodb command to copy the Sports2000 database.

To create a sample database:

1. From the Control Panel or the OpenEdge Program Group, double-click the Proenv icon. The Proenv window appears with the proenv > prompt:

   prodb Sports2004 Sports2000
3. Press Enter. Prodb confirms that the database has been created:

![Proenv window](image)

**Starting the sample database**

This section describes how to start the sample database. In the following example, the database is started with the assumption that OpenEdge is installed locally on your machine.

To start the Sports2004 database from the Proenv window:

1. At the Proenv command prompt, type:

   ```
   proserve Sports2004 -H localhost -S 5555
   ```

   The `proserve` command starts the Sports2004 database.

   - `H` is the database startup parameter that identifies `localhost` as the server on which the database resides.
   - `S` is the database startup parameter that identifies the port through which the database is connected.

   For more on starting databases, see *OpenEdge Deployment: Startup Command and Parameter Reference.*
Open Edge Reporting: Deploying Crystal Reports

2. Press **Enter**.
   Proserve confirms that the Sports2004 database has started:

   ![Proserve confirmation screenshot]

   Now that you have created and started a database, you can configure the ODBC driver and use it to connect to the new sample database.
Configuring the ODBC driver

Setting the correct isolation level is an important step in the driver configuration process. Before configuring the driver it is important to understand some basic concepts about database transactions and transaction isolation levels.

This section covers the following information:

- Understanding transactions and isolation levels
- Adding a new data source

Understanding transactions and isolation levels

SQL defines isolation levels in terms of the inconsistencies they allow:

Table 1–1 identifies which inconsistencies are either permitted or prevented by each isolation level.

Table 1–1: Transaction isolation levels

<table>
<thead>
<tr>
<th>Isolation</th>
<th>Dirty read</th>
<th>Nonrepeatable read</th>
<th>Phantom read</th>
</tr>
</thead>
<tbody>
<tr>
<td>READ UNCOMMITTED</td>
<td>Permitted</td>
<td>Permitted</td>
<td>Permitted</td>
</tr>
<tr>
<td>READ COMMITTED</td>
<td>Prevented</td>
<td>Permitted</td>
<td>Permitted</td>
</tr>
<tr>
<td>REPEATABLE READ</td>
<td>Prevented</td>
<td>Prevented</td>
<td>Prevented</td>
</tr>
<tr>
<td>SERIALIZABLE</td>
<td>Prevented</td>
<td>Prevented</td>
<td>Prevented</td>
</tr>
</tbody>
</table>

Dirty read

A Dirty read occurs when one user is updating or inserting a record. At the same time, a different user is also reading it, but has not yet committed any work to the database.

Nonrepeatable read

A Nonrepeatable read occurs when one user is repeating a read operation on the same records but has updated values.
Phantom read

A Phantom read occurs when one user is repeating a read operation on the same records, but has new records in the results set:

- **READ UNCOMMITTED**
  
  Also called a Dirty read. When this isolation level is used, a transaction can read uncommitted data that later may be rolled back. A transaction that uses this isolation level can only fetch data but can’t update, delete, or insert data.

- **READ COMMITTED**
  
  With this isolation level, Dirty reads are not possible, but if the same row is read repeatedly during the same transaction, its contents may be changed or the entire row may be deleted by other transactions.

- **REPEATABLE READ**
  
  This isolation level guarantees that a transaction can read the same row many times and it will remain intact. However, if a query with the same search criteria (the same WHERE clause) is executed more than once, each execution may return different set of rows. This may happen because other transactions are allowed to insert new rows that satisfy the search criteria or update some rows in such way that they now satisfy the search criteria.

- **SERIALIZABLE**
  
  This isolation level guarantees that none of the above happens. In addition, it guarantees that transactions that use this level will be completely isolated from other transactions.

Based on this information, we can provide basic guidelines for choosing the proper isolation level for the ODBC connection that is going to be used by Crystal Reports:
READ UNCOMMITTED should be used with reports that do not rely on data accuracy. Usually these same reports also process/access a high number of records. This optimizes performance while executing your report with a minimum number of database locks. Examples of reports in this category:

- Statistical information at the end of a month.
- Sales report covering a previous year.
- Reports running daily that accesses data which is rarely updated.
- Reports running daily if the values displayed are only used as indicators.

COMMITTED READ should be used with reports running daily on data that is frequently modified. This enables good performance while executing reports on a “live” database with an average number of record locks that are immediately released. Examples of reports in this category include:

- Daily reports on regularly updated data requiring 100 percent accuracy at the time the report is processed.
- Reports that provide snapshots of an operation at any time during the day. Such reports are used for monitoring purposes, such as stock exchange status reports.

REPEATABLE READ and SERIALIZABLE should not be used with reports as they do not add value at the time the report is generated, especially when compared to COMMITTED READ.

Having reviewed the transaction isolation levels, you can now configure your ODBC driver.
Adding a new data source

Once you have created your sample database and determined the proper isolation level, you can proceed to configure the ODBC Client.

To configure the ODBC client:

1. From the Windows Start menu, choose Settings→Control Panel→Administrative Tools. The Administrative Tools dialog box appears:

![Administrative Tools dialog box]

2. Double-click Data Sources (ODBC) in the Control Panel dialog box:
3. The ODBC Administrator displays the **ODBC Data Source Administrator** dialog box:

4. Click **Add** to display a list of installed drivers. The **Create New Data Source** dialog box appears:

5. Highlight the **DataDirect 4.20 32-BIT Progress SQL v10.0BIP** driver, then click **Finish** to display the **ODBC Progress SQL-92 Driver Setup** dialog box:
6. Specify values for the following:

- **Data Source Name** — Identifies data source configuration name. For example, Accounting.

- **Description** — An optional long description of the data source name. For example, My Accounting Database.

- **Host Name** — The name of the system where the database or database broker is located.

- **Port Number** — The system port number setup for the database listener process.

- **Database Name** — The name of the database to which you want to connect by default.

- **User ID** — The user name used to connect to your OpenEdge database. Your ODBC application can override this value, or you can override it in the Logon dialog box or connection string.

7. Click the **Advanced** tab and specify values for the following:

- **Default isolation level** — use **READ UNCOMMITTED**.

- **Fetch array size** — The number of rows the driver retrieves when fetching from the server. This is not the number of rows given to the user. The default is 50. Enter **500**.
8. Click **Test Connect** to attempt to connect to the data source using the connection properties specified in the **Driver Setup** dialog box. The **Driver Setup** dialog box will display a logon dialog box:

![Logon to OpenEdge SQL 32 Driver](image)

9. Enter your user identification and password and Click **OK**. The OpenEdge SQL driver displays a message box that states the ODBC driver has successfully connected to the database:

![DataDirect Technologies OpenEdge SQL 32 ODBC Driver](image)

Now that you have created a sample database, configured your ODBC driver and established a connection to it, you can use Crystal Reports to create a report using the sample database.
Open Edge Reporting: Deploying Crystal Reports
Creating a Crystal Reports Document

This chapter shows you how to create a simple report using the sample Sports2004 database as described in the following sections:

• Using Crystal Reports to connect to a data source
• Specifying report information
• Running a report
Using Crystal Reports to connect to a data source

To create a report with Crystal Reports you must first connect to a database. Remember, the database must be running in order for you to connect. For information on creating a sample database and connecting to it, see Chapter 1, “Introduction.”

To connect to a running database:

1. Start Crystal Reports by clicking **Start**→**Programs**→**Crystal Reports**. The **Welcome to Crystal Reports** dialog box appears:
2. Select **As a Blank Report** option in the **Create a New Crystal Report Document** area and click **OK**. The **Database Expert** dialog box appears:
3. Click + next to the **Create New Connection** folder to view subfolders. Double click the **ODBC (RDO)** folder. The **ODBC (RDO)** dialog box appears:
4. Select **Accounting** from the **Data Source Name** list and click **Next**. The **ODBC (RDO)** dialog box prompts you for logon information:

![ODBC (RDO) dialog box](image)

5. Enter your user identification and password and click **Finish**. The **Logon to OpenEdge SQL Driver** dialog box appears:

![Logon to OpenEdge SQL Driver](image)
6. Enter your user identification and password and click OK. The Database Expert dialog box appears, showing a list of tables of the database to which you have connected:

Now that you have connected to the database, you can select the specific information you will need for your report.
Specifying report information

Once you have selected a table, you can use the **Database Expert** dialog box to specify the information that will be included in your report.

To specify your report information:

1. At the **Database Expert** dialog box, click + to expand the PUB folder and view the list of tables located in the PUB schema. Click **Customer** to highlight it:

![Database Expert dialog box](image)

**Note:** Once you have selected a table with which to work, you will then identify the columns from which you will extract data for your report. Crystal Reports refers to table columns as data fields.
2. Click > to place Customer in the Selected Tables area and Click OK. The Crystal Reports main dialog box appears:

3. In the Field Explorer area of the Crystal Reports dialog box, click + next to the Database Fields entry to view the list of database tables. Click + next to Customer to view columns (database fields) in the Customer table:
4. Drag and Drop database fields Name, City, and Balance from the Field Explorer to the Details section of the Design tab. The database fields appear in the Details section and the column headers will appear directly above them in the Page Header section.
Running a report

Once you have placed the fields you want in the Details area of the Design tab, running the report is a simple process.

To run a report:

1. Press F5 or click .
   Crystal Reports generates the report on the columns you selected from the Customer table.

2. Save the report as Customer.rpt. You can use it to follow along with procedures that are described in subsequent chapters.
Crystal Reports provides you with a variety of options for formatting your report, including grouping, sorting and totaling. Crystal Reports also enables you to format the visual elements of your report, such as fonts, character styles, borders, graphics and headers.

To demonstrate formatting features, this chapter shows how to format a report on the Customer table of the Sports2004 sample database. For procedures on creating a sample database, see Chapter 1, “Introduction.”

Specifically, this chapter covers:

- Organizing report data
- Defining report appearance

**Note:** This chapter provides only introductory information on report formatting. For detailed information on formatting reports and organizing data within a report, refer to the Crystal Reports User’s Guide and online Help.
Organizing report data

Keeping your data well organized will help ensure that your report is easy to read. This section provides some basic procedures for organizing report data so information can be easily and clearly understood by the reader.

Specifically, this section covers:

• Defining a record selection criterion
• Grouping records
• Setting record order
• Adding summaries

Defining a record selection criterion

The Select Expert allows you to define limitations to record selection criteria. It works similar to the WHERE clause of an SQL query statement. The Customer report created in the previous chapter provided information on all customers worldwide. The following set of procedures shows how to narrow that list to a specific subset.

To define a record selection criterion:

1. Click Report → Select Expert. The Choose Field dialog box appears:
2. Click **State** and then **OK**. The **Select Expert** dialog box appears:

![Select Expert dialog box](image1)

3. From the drop down menu of the **Customer.State** tab, select **is one of**. A drop down menu for the states appears:

![Select Expert dialog box](image2)

4. The revised report will feature information on the New England States exclusively. Select **CT, MA, ME, NH, RI, and VT**. The **Customer. State** tab is now complete:

![Select Expert dialog box](image3)
5. If the report is designed to provide information on customers with outstanding balances, you can eliminate the customers who do not fit this profile. Click the <New> tab. The Choose Field dialog box appears:

6. Select the Balance field and click OK. The Customer.Balance tab appears in the Select Expert dialog box:

7. Select is not equal to from the drop down list. An adjacent drop down list will appear to the right. Select 0.00 and click OK. Crystal Reports displays a warning that there has been a change to the selection criteria:

8. Click Refresh Data. The number of records displayed in the report drops from 1,117 worldwide customers to just 53 New England customers with outstanding accounts.
Grouping records

A well-designed report is organized so readers can easily analyze information. Grouping similar sets of records helps readers isolate and study specific information. The following procedure shows an example of grouping using the Customer report.

To group records:

1. Click **Group** → **Group Expert**. The **Group Expert** dialog box appears:

   ![Group Expert dialog box](image)

2. Select **State** from the **Available Fields** list, click > to move the selection to the **Group By** area and click **OK**. The customer records are now grouped according to the states in which they are located.

   ![Grouped customers](image)
Setting record order

Records ordering allows you to prioritize the appearance of specific pieces of information in the report. Records are sorted so information can be presented in a way that is most helpful to the reader. In the following example, records will be sorted so customers with greater outstanding balances are listed first.

To set record sort order:

1. Open the Record Sort Order window by clicking . The Record Sort Order Window appears:
2. Move the fields you want to sort to the **Sort Fields** area by selecting them from the **Available Fields** list and then clicking >. The field names move to the **Sort Fields** area:

![Record Sort Order dialog box](image)

3. Select the field when it is the **Sort Fields** area, and then choose **Descending** from the **Sort Direction** options. Click **OK** when finished. Records in the report are now grouped by state and each state’s records are ordered from those with the largest to smallest account balances:

<table>
<thead>
<tr>
<th>State</th>
<th>Company Name</th>
<th>Account Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CT</td>
<td>Changes Sports</td>
<td>32,382.64</td>
</tr>
<tr>
<td></td>
<td>Old Usa</td>
<td>31,939.11</td>
</tr>
<tr>
<td></td>
<td>B &amp; M Door Shop</td>
<td>30,355.17</td>
</tr>
<tr>
<td></td>
<td>Seaview Courts Inc</td>
<td>29,835.59</td>
</tr>
<tr>
<td></td>
<td>Connecticut Sporting Goods</td>
<td>23,219.58</td>
</tr>
<tr>
<td></td>
<td>Jay's Sport &amp; Trophy</td>
<td>11,303.00</td>
</tr>
<tr>
<td></td>
<td>Oakwood Sports &amp; Fitness</td>
<td>8,133.22</td>
</tr>
<tr>
<td></td>
<td>Shihan Martial Arts &amp; Sport</td>
<td>7,270.03</td>
</tr>
<tr>
<td></td>
<td>Epic Sport Works</td>
<td>5,041.01</td>
</tr>
<tr>
<td></td>
<td>Santarinius Sports Ltd</td>
<td>2,213.87</td>
</tr>
</tbody>
</table>
Adding summaries

Crystal Reports provides many tools for analyzing information that has been drawn from a database. A good example is the ability to summarize data. To demonstrate this feature, a summary of the account balances will be added to the Customer report.

To add a summary:

1. Click \( \sum \). The **Insert Summary** dialog box appears:
2. Select **Customer.Balance** as the field to summarize, select **Sum** as the calculation to make to the summary, and place the summary in the **Customer.State** group. After making those choices, click **OK**. The sum of all outstanding accounts for each state appears at the end of each group:

<table>
<thead>
<tr>
<th>State</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>North Kingston</td>
<td>31,300.90</td>
</tr>
<tr>
<td>Portsmouth</td>
<td>27,243.04</td>
</tr>
<tr>
<td>Cranston</td>
<td>27,140.26</td>
</tr>
<tr>
<td>East Greenwich</td>
<td>15,980.77</td>
</tr>
<tr>
<td>Cranston</td>
<td>15,430.16</td>
</tr>
<tr>
<td>Harrisville</td>
<td>9,580.12</td>
</tr>
<tr>
<td>Newport</td>
<td>7,888.99</td>
</tr>
<tr>
<td>Providence</td>
<td>5,831.71</td>
</tr>
<tr>
<td>Lincoln</td>
<td>656.73</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>139,677.50</td>
</tr>
</tbody>
</table>

3. Click **Insert Summary** once more. The **Insert Summary** dialog box appears:
OpenEdge Reporting: Deploying Crystal Reports

4. Choose Customer.Balance once again as the field to summarize. Select Sum as the calculation to make. Select Grand Total (Report Footer) as the location for the summary. Click OK. A grand total of all outstanding accounts appears at the end of the report.

<table>
<thead>
<tr>
<th>Sport about</th>
<th>Essex Junction</th>
<th>2312.88</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balances Sport Shop</td>
<td>Brattleboro</td>
<td>831.18</td>
</tr>
<tr>
<td></td>
<td></td>
<td>107,007.40</td>
</tr>
<tr>
<td></td>
<td></td>
<td>907,323.84</td>
</tr>
</tbody>
</table>

Defining report appearance

This section shows how to define the appearance of a basic report. Crystal Reports enables you to manipulate font families or character styles, add borders, pictures, coloring or shading to enhance the appearance of your report, as described in the following sections:

- Creating report and page headers
- Arranging fields
- Modifying text
- Adding a template

Creating report and page headers

Report Headers and page headers can be created by placing text objects in the header sections of the Design tab. Report headers appear at the top of the first page of the report. Page headers appear at the head of each page.

To create a header:

1. Click \( \text{ab} \). Crystal Reports creates a text object box.
2. Drag the text object to the point in the header area where you want it to be placed and click on that spot. Crystal Reports drops the text object:
3. Enter the text you wish to appear in the box and click outside the box. The text box is placed in the header section of your choice:

![Department Accounting Report](image)

**Arranging fields**

Fields can be arranged within a report by clicking and dragging.

To move a field in the Design tab:

1. Click on the field. The field becomes highlighted.

   ![Department Accounting Report](image)

2. Click and drag the field to the new area, using the horizontal and vertical rulers as a guide.
#### Modifying text

Once you have placed a text object within your report, you can change text characteristics to fit the overall appearance of your report.

To modify text:

1. Right click within the text object. The **text pop-up menu** appears:

![Text Pop-up Menu](image1)

2. Click **Format Text**. The **Format Editor** appears:

![Format Editor](image2)
3. Click on the **Font** tab. The **Font** tab appears:

![Font tab image]

4. Use the drop down menus to change font, style, size and color. Click **OK** when you have completed your selections. The remaining tabs within the Format Editor can also be used to add borders, colors, shading and other visual elements to the report:

```
Corporate Accounting Department

<table>
<thead>
<tr>
<th>Name</th>
<th>City</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Champions Sports</td>
<td>Farmington</td>
<td>22,392.04</td>
</tr>
<tr>
<td>Gold Leaf</td>
<td>New London</td>
<td>31,039.11</td>
</tr>
<tr>
<td>B &amp; M Gun Shop</td>
<td>Arlington</td>
<td>30,355.17</td>
</tr>
<tr>
<td>Seaview Scuba Inc</td>
<td>New London</td>
<td>29,815.55</td>
</tr>
<tr>
<td>Jay's Sport &amp; Tackle</td>
<td>Ansonia</td>
<td>11,390.90</td>
</tr>
<tr>
<td>Oakwood Sports &amp; Fishing Ctr</td>
<td>Glastonbury</td>
<td>9,131.22</td>
</tr>
<tr>
<td>Shihan Martial Arts &amp; Sporting</td>
<td>Tallahassee</td>
<td>7,370.63</td>
</tr>
<tr>
<td>Epic Sport Works</td>
<td>Sterling</td>
<td>5,841.01</td>
</tr>
<tr>
<td>Santorius Sports Ltd</td>
<td>Avon</td>
<td>2,219.07</td>
</tr>
</tbody>
</table>

Total for State: **$183,603.66**
```
Adding a template

Crystal Reports offers predefined report templates that can be used to apply a uniform style to the visual components of your report. The template defines a report’s visual characteristics, such as font size and color, borders, and background colors or shading.

To add a template to your report:

1. Click \(\text{\textbullet\textbullet\textbullet}\). The Template Expert dialog box appears:
2. Select a template from the **Available Templates** list and click **OK**. Crystal Reports applies the template to your report:

![New England Accounts](image)

When you apply a template, elements of the report may not appear exactly as you would like. Working from the Design tab, you can make any needed modifications, such as moving fields or changing font sizes.
Because Crystal Reports provides users with database access, it is important to consider what types of access privileges are granted, and how those privileges affect database security, as described in the following sections:

- Using logon validation
- Assigning privileges
- Using password protection
Using logon validation

Logon validation is a mechanism that checks user identification and password at connection time using reference data stored in the OpenEdge RDBMS.

In the OpenEdge RDBMS, the reference table storing user identifications and passwords serves both OpenEdge SQL and Progress 4GL interfaces. Use the `CREATE USER` statement to enable logon validation from the SQL interface. Use the OpenEdge Data Administration tool to enable logon validation from the Progress 4GL interface. Logon validation can be disabled from either interface.

Creating, altering, or dropping a user via SQL is equivalent to creating, maintaining, or deleting a user with the OpenEdge Data Administration tool. The user list updated for the OpenEdge SQL interface is updated for the Progress 4GL interface and vice-versa.

In an environment where an OpenEdge RDBMS is accessed by applications using both Progress 4GL and SQL, the following conditions exist:

- **If no users have been created**—The Progress 4GL interface will not display a logon dialog box, but the OpenEdge SQL interface will. Anything may be entered in the user identification field and the password field may be left blank.

- **If users have been created**—Users accessing the database through the Progress 4GL interface are required to provide an identification and password only when the DBA has specifically mandated the practice. Furthermore, users working from the 4GL interface by default have unlimited privileges. The DBA who controls access from the 4GL interface must place limitations on user privileges or restrict access to certain database objects.

Users accessing the database through the OpenEdge SQL interface are required to provide an identification and password. Users do not have privileges until they are specified by a DBA.
Logon validation guidelines

- If your OpenEdge RDBMS is accessed only through the OpenEdge SQL interface, you should enable logon validation to ensure only authorized users have access.

- If your OpenEdge RDBMS is accessed through both the OpenEdge SQL and Progress 4GL interfaces and the 4GL does not require logon validation, then you should not enable SQL logon validation unless you intend to modify your 4GL application and make full use of this feature.

- If your OpenEdge RDBMS is accessed through the OpenEdge SQL and 4GL interfaces and the 4GL already uses logon validation, then you must use logon validation for OpenEdge SQL.

For information on creating logon validation for the OpenEdge SQL interface, see OpenEdge Data Management: SQL Development.

For information on creating logon privileges using the Progress 4GL interface, refer to the online help for the OpenEdge Data Administration tool.
Assigning privileges

Database administrators also control access to a database by assigning user privileges. SQL DBAs use the GRANT and REVOKE statements to authorize privileges for users who are working with the OpenEdge SQL interface. Privileges granted to users of the Progress 4GL interface are maintained separately using the OpenEdge Data Administration tool.

A DBA may grant specific privileges - such as selecting, updating, or deleting records - to individual users or to all users. When working through the SQL interface, all user actions against a database are prohibited unless explicitly authorized by the DBA. When users attempt to perform an action for which they do not have privileges, the OpenEdge SQL server generates an error message.

Conversely, all users working through the Progress 4GL interface have unlimited database privileges, unless those privileges are explicitly restricted by the DBA. Database privileges are defined for the Progress 4GL interface by using the OpenEdge Data Administration tool.

DBAs must exercise caution when deciding which privileges should be assigned and to whom. For example, if a table or view is selectable by all users, the DBA can grant the ability to select data to the public. Otherwise, the privilege to select data should be granted to those individuals who have a need to do so. The same principle applies to other privileges, such as updating records or executing stored procedures.

For information on user privileges and the OpenEdge SQL interface, see *OpenEdge Data Management: SQL Development*.

For information on user privileges and the Progress 4GL interface, refer to the online help the OpenEdge Data Administration tool.
Using password protection

Crystal Reports provides you with the ability to establish password protection for individual reports. It is independent from operating system validation or database logon validation. This mechanism ensures sensitive report data is accessed only by authorized individuals.

This section provides information on:

- Creating a new report parameter
- Creating a new password
- Verifying your new password

Creating a new report parameter

The following procedures demonstrate how to create a new report parameter that will enable password protection for the Customer report. You will need to open Customer.rpt to follow these examples.

To create a new report parameter:

1. In the Field Explorer area, right-click Parameter Fields and click New. The Create Parameter Field dialog box appears:

2. Type Password in the name field.

3. Type Enter your password to view restricted information in the Promting text field.
4. Select **String** from the **Value type** drop-down menu.

5. Select **Discrete value(s)** from the **Options** list and click **Set default values**. The **Set Default Values** dialog box appears:

![Set Default Values dialog box]

6. Type **password** in the **Edit mask** field. This will hide the entry value with asterisks. Click **OK**.

7. At the **Create Parameter Field** dialog box, click **OK**.

Now that you have created a new parameter field, you can create a password that will be associated with it.
Creating a new password

Use the Section Expert dialog box to create the password. The Section Expert enables you to suppress report sections from view until a user has provided a password that enables viewing.

To create a new password:

1. From the main menu bar, click Report→Section Expert. The Section Expert dialog box appears:
2. In the **Sections** area, click the report section you wish to conditionally hide and display using the password. Select **Suppress (No Drill-Down)** in the Common area, then click the adjacent button. The **Formula Workshop** dialog box appears:

3. Double-click **password** from the **Report Fields** list. `{password}` appears in the formula work area.

4. Type `<> “Customer”` next to `{password}`.

5. Click to make sure your formula is correct. If your formula is correct, the following message appears:

6. Click **Save and close** and then click **OK** in the **Section Expert** dialog box. You have now created a password for your report.
Verifying your new password

Now that you have created the password, you can check to ensure that the feature is working in your report.

To verify your report password works:

1. Click . The **Refresh Report Data** dialog box appears:

   ![Refresh Report Data dialog box](image)

   ![Refresh Report Data dialog box](image)

2. Select **Prompt for new parameter values** and click **OK**. The Enter Parameter Values dialog box appears:

   ![Enter Parameter Values dialog box](image)

   ![Enter Parameter Values dialog box](image)
3. Enter your password in the **Discrete Value** field and click **OK**. Your report appears with all detail information:
4. Repeat Steps 1 and 2. At the Enter Parameter values dialog box, enter a value other than your password in the Discrete Value field and click OK. The Details section of your report remains hidden:
OpenEdge Reporting: Deploying Crystal Reports
Index

A
Adding
- data sources 1–8
- summaries 3–8
- templates 3–14
Administrative tools 1–8
Arranging
- data fields 3–11
Assigning
- data privileges 4–4

C
Configuring
- ODBC driver 1–5
Connecting
- data source 2–2
Connections
- database 1–11
Creating
- page headers 3–10
- report headers 3–10
- sample databases 1–2

D
Data fields
- adding 2–8
- arranging 3–11
- defined 2–7
- moving 3–11
Data source
- connecting 2–2
Data sources
- adding 1–8
Databases
- connections 1–11
- copying 1–2
- creating samples 1–2
- security 4–1, 4–2
- starting 1–3
- startup commands 1–3
- transactions 1–5
- user privileges 4–4
DBAs
- security responsibilities 4–4
Defining
- record selection 3–2
- report appearance 3–10
Dirty read 1–5
OpenEdge Reporting: Deploying Crystal Decisions

F
Format Editor
3–12
Formula Workshop 4–7

G
Group Expert
Using 3–5
Grouping
records 3–5
Guidelines
logon validation 4–3

H
Headers
page 3–10
report 3–10

I
Isolation level
SERIALIZABLE 1–6
Isolation levels
READ COMMITTED 1–6
READ UNCOMMITTED 1–5
REPEATABLE READ 1–6
understanding 1–5

L
Logon validation 4–2

M
Modifying
text 3–12
Moving
data fields 3–11

N
Nonrepeatable read 1–5

O
ODBC driver
configuring 1–5
Ordering
records 3–6
Organizing
report data 3–2

P
Passwords
creating 4–5
data security 4–5
Section Expert 4–7
verifying 4–9
Phantom Read 1–6
Proenv 1–2

R
Read
dirty 1–5
nonrepeatable 1–5
phantom 1–6
READ COMMITTED 1–6
READ UNCOMMITTED 1–6
Records
grouping 3–5
ordering 3–6
selection criteria 3–2
Index

REPEATABLE READ 1–6

Report information specifying 2–7

Reports
appearance 3–10
headers 3–10
organizing data 3–2
page headers 3–10
running 2–10
summaries 3–8

Running reports 2–10

S

Section Expert passwords 4–7

Security

databases 4–1
DBA responsibilities 4–4
logon validation 4–2
password protection 4–5
Progress 4GL interface 4–2
user privileges 4–4

Select Expert using 3–2

SERIALIZABLE 1–6

Specifying report information 2–7

Sports2000 1–2

SQL
query statement 3–2
security 4–2
user privileges 4–4

Startup commands 1–3

Summaries adding 3–8

T

Template Expert 3–14

Templates adding 3–14

Testing database connections 1–11

Text appearance 3–12
modifying 3–12

Tools administrative 1–8

Transactions database 1–5
phenomena 1–5

U

Using Select Expert 3–2

V

Verifying passwords 4–9

W

WHERE clause 3–2